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Customer Support 

 
NRG Systems offers a variety of support options to help you get the most from your NRG product.  If you have questions 
about your NRG product, first look in the printed product documentation or the Knowledge Base in the Tech Support 
section of NRGôs web site.  If you cannot find the answer, contact your salesperson or NRG Systems Technical Support 
for assistance using the information below.  Customer support is available 8:30 AM to 5:00 PM EST, Monday through 
Friday.   

   
 NRG Systems, Inc.  Telephone: 802-482-2255 
 110 Riggs Road  Toll Free (USA only): 800-448-WIND (800-448-9463) 
 Hinesburg, Vermont  FAX: 802-482-2272 
 05461 U.S.A.   Email: support@nrgsystems.com 
 

When you call or email, you should have the appropriate product documentation at hand and be prepared to give the 
following information: 

 

 Customer name 

 Who purchased equipment 

 Item number or description 

 Serial number 

 When equipment was purchased 

 Where equipment is installed - terrain conditions 

 Description of the problem with some detail 

 What events took place leading up to the problem 

 What you have tried while attempting to solve the problem 
 
NRG Systems maintains an extensive website which includes an in-depth customer support area for NRG customers.  If 
you need assistance at times other than our regular business hours, we suggest visiting our website, 
www.nrgsystems.com. 
 

 
 

All instruments, sensors, software and towers manufactured by NRG Systems are designed to be reliable and easy to 
use.  We welcome your comments and appreciate your help in making NRG products the best available. 





Introduction 
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Introduction 

Welcome! 

Congratulations on your purchase of the SymphoniePLUS data logger.  The revolutionary SymphoniePLUS data logger is 
part of the worldôs most advanced internet enabled data logger system.  It gives you all the accuracy and durability of 
other NRG loggers, but allows you to collect data without leaving your desk.  SymphoniePLUS stores data on a standard 
MMC card.  With an optional NRG iPack, you can send data via your Internet provider over an embedded standard, 
satellite, or cellular phone.  You get an email with an attached data file at any interval you choose. 
 
The SymphoniePLUS is a natural evolution from the Symphonie logger.  Built on the proven circuit designs of the 
Symphonie, SymphoniePLUS offers 3 additional NRG #40C anemometer (or compatible) channels which allow users to 
get more data from a single tower.  Optional plug-in Signal Conditioning Modules (SCMs) are available and pre-configured 
to work with sensors from NRG or other manufacturers. 
 
The look and feel of SymphoniePLUS as well as the menu structure and user programming tasks remain largely 
unchanged from Symphonie. The new channels appear in the standard menus and default to the NRG #40C anemometer 
published transfer function. 
 
If you can program a Symphonie, you already know how to program a SymphoniePLUS! 
 
The complete internet enabled SymphoniePLUS data logger system is comprised of the SymphoniePLUS data logger; 
optional iPack kit for CDMA cellular, GSM cellular, or satellite communications, plus Symphonie Data Retriever Software.  
Starting in June 2010, all Symphonie iPacks will ship pre-configured for WindLinx wireless service.  WindLinx allows for 
uniform activation of communications services and features the WindLinx web portal, which allows for remote 
management and monitoring of wireless account activity.   

Using This Manual 

The SymphoniePLUS logger Userôs Manual is an indispensable part of the SymphoniePLUS logger system.  Read this 
manual completely before installing and operating the SymphoniePLUS logger.  Follow all instructions and 
recommendations closely.  Several checklists and forms have been included to facilitate preparing for installation and site 
visits.  Avoid jeopardizing the reliability of your data collection system by being prepared with the required information and 
tools. 
 
This document and the instruments described herein may use the following symbols: 
 

 Earth (Ground)   Read the Manual   DC Voltage 

Definitions 

This type style is used for the general body of this manual and is used for general descriptions and instructions to the 
user.  

 
Instructions in Bold Type refer to Symphonie Data Retriever Software and require you to press a button on the computer 
screen, open a file, or select from a program menu.  For example:  File>Open. 
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Instructions in [Brackets] refer to SymphoniePLUS logger keypad navigation and require you to press a series of keys to 
perform a specific function.  For example, pressing the [Home/Esc] key will always return the display to the Main Menu. 

 

This type style is used to show actual prompts and messages that appear on the logger 

display.  

 

This type style is used to warn users of a potential danger, either to themselves or to the equipment or data.  

SymphoniePLUS Set-up Overview  

SymphoniePLUS is a very flexible logging system that can be set up as a stand alone unit or as an internet enabled 
logging system.  When used as a stand alone unit, data files are retrieved manually through regular site visits.  When 
used in conjunction with a snap-on CDMA, GSM, or satellite communications iPack, data files are delivered to the user as 
email attachments. 
 

Stand Alone Users (no iPack) 

Stand alone SymphoniePLUS configuration is fairly straightforward for those familiar with data loggers.  Follow the 
sections on logger setup carefully.  Stand alone users may skip the headings in this manual referring to iPacks and do not 
need to install the SDR software in order to configure a logger.  All software related operations including software 
installation can be skipped until files need to be processed.   

Internet Enabled Users (with iPack installation) 

This manual provides full instructions in a chronological order for SymphoniePLUS  / iPack systems.  It is recommended 
that the manual be followed in chronological order for configuring an iPack system.  As of June 2010, all iPacks ship pre-
configured for WindLinx wireless service.  Through WindLinx unified wireless service, iPack users can set up internet 
service provider accounts in addition to cellular or satellite accounts from a single provider.  The WindLinx web portal will 
generate necessary programming parameters for the iPack.   

Theory of Operation 

The NRG SymphoniePLUS data logger is an internet ready, ultra-low power microprocessor-controlled data logging 
system specifically designed for the wind energy industry.  Addition of communication iPacks allows for internet transfer of 
data via email.  CDMA, GSM, and satellite iPacks can be easily connected to the back of the SymphoniePLUS logger to 
enable remote internet communications.   

 
The SymphoniePLUS logger has a fixed averaging interval of 10 minutes.  Each of the 15 channelsô averages, standard 
deviations, and other statistical values are calculated from continuous 2 second data samples.  Data intervals are 
calculated every 10 minutes, time stamped with the beginning time of each interval and written to the MultiMedia Card 
(MMC) at the top of each hour.  
 
Symphonie Data Retriever (SDR) software is then used to process raw data files stored on your computer either from an 
MMC Reader or email.  Configuration of iPacks is also performed by the SDR software with the use of a programming 
cable.  
 
Sensor scales and offsets programmed into the SymphoniePLUS logger can be edited later with SDR if there is a mistake 
or if a sensor is added or changed.  The parameters in SDRôs Site Information Editor are used to create the tab-delimited 
text file (ASCII), so there is always an opportunity to make changes to how the raw files will be processed before 
generating ASCII data files. 
 

Features of the SymphoniePLUS Logger System 
 

The SymphoniePLUS logger is a 15 channel data logger optimized for the needs of the wind energy assessment user.  It 
is designed to be easy to install and reliable in any climate. Wherever you need to measure the wind, no matter how 
demanding the environment, SymphoniePLUS and the ñplug and playò iPacks make data collection as easy as reading 



Introduction 

 
15 

NRG_SymphoniePLUS_Data_Logger_Manual_-_Rev_1.04.docx                        13 July, 2010 

your email. 
 

 It provides up to 9 counter inputs used for measuring wind speed or other frequency signals such as rain gauges 
or other totalizer type sensors. 

 

 It provides up to 6 analog channels used for measuring wind direction or a range of other parameters including 
temperature, barometric pressure, relative humidity and solar energy. 

 

 The SymphoniePLUS logger is wind energy industry specific and pre-configured to industry standards.  All 
features for wind energy assessment are built in. SymphoniePLUS requires no complex configuration. 

 

 Convenient ñplug and playò Signal Conditioning Modules (SCMs) are pre-configured for a large variety of 
additional sensors. 

 

 Configuration of channels 4-6 and 9-12 can be altered at any time for different sensors by simply changing the 
corresponding SCM.  

 

 SymphoniePLUS uses non-volatile FLASH MultiMedia Cards (MMC) for data storage.  Cards are available almost 
anywhere in the world and are safer for data storage than RAM memory. 

 

 The standard NRG MMC provides over 2 years of data storage. 
 

 Average, Standard Deviation, Maximum and Minimum values are recorded for all wind speeds and most analog 
channels at every 10 minute interval.  Set up is done for you. 

 

 Free Symphonie Data Retriever Software is included and produces versatile tab-delimited text files.  Data files 
can be used with a wide range of data processing software, including SQL databases, Microsoft Excel and 
Access, and more.  International numeric formats are supported. 

 

 The 4 line x 20 character display is easy to read and provides easy to understand real-time data and configuration 
information. 

 

 Dedicated navigation buttons (up, down, left, right, home), plus a data entry keypad make the full-text, menu 
driven display easy to use. 

 

 Separate lithium battery-backed real-time clock provides accurate and reliable time stamping. 
 

 Wiring panel provides additional gas tube ESD protection for each input channel. 
 

 SymphoniePLUS runs on two alkaline D-cells (included) for up to one year, depending on sensor configuration. 

 
 iPack kits for CDMA cellular, GSM cellular, and satellite communications provide remote data collection via e-

mail. 
 

 PV-only iPack kits provide additional power for higher consumption sensors such as barometric pressure sensors 
or relative humidity sensors. 

 

 Loggers with iPacks allow remote changes to sensor configuration and communication parameters via email. 
 

 Symphonie Data Retriever Software allows pre-installation programming of iPacks through a programming cable. 
 

 Call Now and antenna test features allow on-site testing of iPack communications. 
 

 iPack battery can be recharged after office testing using a convenient wall charger (available from NRG). 
 

 Symphonie Data Retriever Software version 6 and later is compatible with data from SymphoniePLUS, 
Symphonie, Wind Explorers, 9200-PLUS, and 9300 series loggers and their readers (DataPlug Reader, 
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EEReader II). 
 

 Improved support for DBCS systems. 
 

 Data filtering in Symphonie Data Retriever Software can exclude icing data and faulty sensor data from reports. 
 

 Support for SMTP authentication for iPacks version 14 and later. 
 

 POPAuto feature included with Symphonie Data Retriever Software automates extraction of emailed data.  
 

 Convenient access to complete sensor history information in the Site Information Editor screen. 
 

 Customized ASCII export available. 
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Precautions 

 

Notes for First Time Users  
 

It is recommended that you take the time to become familiar with your new logger and its operation before going out in the 
field.  Please read the manual and experiment with all the functions and features of the SymphoniePLUS data logger.   

 
Practice the following in your office before going to the field: 
 

 installing SCM cards 

 setting SymphoniePLUS parameters 

 attaching the sensors to the SymphoniePLUS logger  

 using the keypad 

 formatting and changing MMC cards 

 changing batteries 

 installing and configuring iPacks 

 using Symphonie Data Retriever Software 

 transferring data from the SymphoniePLUS logger to your PC using the supplied MMC card reader 
 

Grounding 

 
Whenever coming in contact with the SymphoniePLUS logger, either in the field or indoors, it is good practice to first 
grasp a piece of grounded (earthed) metal to avoid a potentially damaging electrostatic discharge (ESD) to the logger. 

 
Meteorological sensors, loggers, and towers will accumulate static charge unless they are properly grounded. Both high 
wind speeds and low humidity increase the rate of charge accumulation.  Static charge can change the electric potential 
of the logger and sensors by thousands of volts relative to ground.  Charge will continue to accumulate until the developed 
voltage difference causes dielectric breakdown and static discharge. 
 
Electrostatic discharge will damage any scientific instrument, including a SymphoniePLUS logger.  It is very important that 
you ground your logger immediately after mounting and prior to connecting a sensor.  If a ground rod cannot be driven 
into the ground at the base of the tower, a grounding cable should be buried in the ground for sufficient distance to reduce 
the resistance between the logger ground stud and the earth.  Failure to ground a SymphoniePLUS logger will cause 
damage to the logger, sensor damage, and loss of data.   
 
Equipment that is not properly grounded is not covered by NRG Systems warranty. 

Recharging the iPack Battery 

Lead acid batteries such as the one used in the SymphoniePLUS iPack need to be kept fully charged.  It is very important 
to recharge the iPack before installing it in the field, especially after programming or communications testing.  All lead acid 
batteries will lose their capacity over time.  Therefore, the battery must be recharged if an iPack is kept in storage or is 
unused for any period of time.  An iPack battery charger is available from NRG Systems (item #3615). 
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iPack3 models (released April 2006) have an additional set of terminals for a 12 V external power source (battery bank 
with charge controller, for example).  Please review the following table to make sure you are making the correct 
connections. 
 

Connection Point Do Do NOT Functional Notes 

PV Terminals 
Doéconnect PV panels, DC power 
sources between 14 and 28 V DC 

Do NOTéconnect power sources in 
excess of 28 V DC, including large PV 
panels 

The PV terminals will charge the iPackôs 
internal battery; the PV terminals will NOT 
charge an external battery. 

External Battery 
Terminals 

Doéconnect 12 V battery and/or 
external charge controller up to 14.3 V 
DC 

Do NOTéconnect PV panel or power 
sources in excess of 14.3 V DC 

The external battery terminals are an input 
only, an external battery will NOT be 
charged from the iPack through these 
terminals nor will the internal iPack battery. 

Ground Terminal Doéconnect to logger ground stud 
Do NOTéleave disconnected or connect 
other wires such as shields 

This terminal will help provide protection 
from electrostatic discharge for the iPack 
and logger. 

 
If the iPack battery is not fully charged before being installed in the field, the battery may discharge faster than the 
photovoltaic panel can recharge it.  This is more likely when using sensors with higher power consumption such as 
barometric pressure and relative humidity sensors.  Like most lead acid batteries, if the iPack battery remains at low 
capacity for an extended period of time, the battery will no longer accept or maintain a charge. 
 

Environmental Considerations 

 
 Grounding requirements are site specific; determine soil type before installation.  
 Sensor cables become less flexible and are more easily damaged at very low temperatures. 

 Make sure that all sensor cables are securely fastened to the tower so they do not flap in the wind. 

 Be sure that all connections are tight and securely fastened to ensure reliability in high winds.   

 Low temperatures can diminish battery performance.  Always use good quality alkaline batteries, and always stay 
within reasonable limits when establishing your battery replacement schedule. 

 Make sure that all sensor cables are spiral wrapped (2 wraps every three meters) around the tower to discourage 
natural frequency vibrations.  Use a high quality electrical tape rated for extreme conditions to further secure the 
cables to the tower.   

  

Site Records 

 
Understanding the assignment of site numbers is the single most important step in setting up a wind assessment 
system. 

 

 The SymphoniePLUS logger system requires that you assign a unique site number to each logger site. 

 The assigned site number must stay with the site even if the tower, sensors, and logger are dismantled and moved 
to another location.   

 An abandoned site number is never re-used or assigned to a new location.  It remains as a reference to the 
historical data from the abandoned site.  

 
An accurate description of each site is essential to your wind measurement program.  Your SymphoniePLUS logger can 
be configured to label datasets with the following information: 
 

 Latitude and longitude 

 Site elevation 

 Sensor heights 
 

It is advisable to record additional site information that may help in the analysis of your data: 
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 Type of terrain (open plain, mountainous forest, etc.) 

 Type and height of trees 

 Type of climate 

 A topographic map of the area 
 

Additional procedures and recommendations for keeping good site records can be found in the American Wind Energy 
Associationôs siting standards document: Standard Procedures for Meteorological Measurements at a Potential Wind 
Turbine Site.  This document can be found on the AWEA web site, www.awea.org. 
 
In the Appendices, weôve provided some blank site data sheets that may be helpful in organizing this information. 

http://www.awea.org/
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SymphoniePLUS Logger Components (Quick Tour) 

Unpacking the SymphoniePLUS Logger System 
 

Follow standard precautions for handling electronic components when unpacking the SymphoniePLUS logger.  
Discharge static electricity from your body by touching a piece of grounded metal or wearing a ground strap.  

 

Do not remove the brown desiccant pack from the clear plastic package at this time. During the field 
installation procedure, you will remove the clear wrapper and place the desiccant pack inside the 
logger enclosure to keep it dry. 

 

Confirm that you have received all components by comparing your order to the packing list shown below.  Immediately 
contact NRG Systems if any of the components are missing.  
 

You should find the following standard equipment: 
 1 ï SymphoniePLUS data logger unit 
 2 ï 1.5 volt D-cell alkaline batteries 
 1 ï 3 volt lithium clock battery (installed) 
 1 ï 8 foot (2.43 meter) 10 Ga. ground cable with connector  
 2 ï 10-32 hex machine nuts 
 4 ï 10-32 x 0.50 inch (13 mm) mounting screws 
 1 ï desiccant pack 
 1 ï NRG MMC card with protective case 
 1 ï field wiring panel  
 1 ï CD containing Symphonie Data Retriever Software 
 1 ï screwdriver with NRG logo 
 

Be sure to double-check your order for any optional equipment ordered, such as SCMs, extra MMCs, etc. 
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SymphoniePLUS Logger Components Map 
 

Here is an illustration of the logger with the cover open, the battery cover removed, and all seven additional SCMs 
installed.  All of the main components are labeled. 
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 Two field types are utilized when programming the SymphoniePLUS logger - numeric only and alphanumeric.  While 
in a numeric only field, pushing a numbered key allows direct entry of any numeric value.  While in alphanumeric 
fields, the keys will scroll through each of the assigned characters.  For example, push the [2] key, and it types the 
number ñ2.ò  Push the same key again and it types the letter ñAò or ña.ò  Press the same key again, and it types the 
letter ñBò or ñb.ò  The navigation keys in the top row are used to toggle between upper and lower case letters (see 
below). 

 In this manner, the digits 0-9, the entire alphabet, as well as special characters, can all be entered utilizing only ten 
keys.   

 The zero [0] key can be used to enter a blank space or the characters ñ*ò and ñ#.ò   Pressing the [Home/Esc] key will 
always return the display to the Main Menu. 
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 Take some time to experiment with the keypad to become familiar with its operation. 

Navigation keys 

The keys in the top row are the navigation keys ï left, down, up and right.  These keys can be used to page forward and 
backward, move the cursor on data entry screens, and enter decimal points ñ.ò or negative ñ-ò characters.  Additionally, the 
up and down keys are used to toggle between capital and lower case letters in alphanumeric fields.  

Display 

 The liquid crystal display is built into the logger to facilitate site visits and is activated by pressing any key on the 
logger keypad.  The user can view present wind conditions and logger parameters without additional equipment.   

 As a power saving function, the display will always shut off after one minute without any key inputs.  The logger 
continues to collect data while the display is off.  

D-cell Batteries 

The logger runs on standard D-cell batteries which are protected by a battery cover.  It is recommended that high quality 
alkaline batteries are used (such as Energizer or Duracell).  Batteries should be changed one at a time so that logging 
operations are not disrupted during the battery change.   

Input connector 

This male DB-37 connector interfaces to the field wiring panel.  Sensor wires are connected to the field wiring panel with 
the supplied NRG screwdriver. 

iPack access port 

This port allows connection of the Programming Adapter for iPack programming while the iPack is connected to the 
logger. 

Ground stud 

This 10-32 stud is designed to be connected directly to earth ground with the supplied ground cable.  The logger must be 
grounded! 

Clock battery 

A lithium battery powers the logger clock even if D-cell batteries are not present.  This allows the logger to retain date and 
time in the event of a reboot.  Clock batteries will last many years under normal use. 

Clock battery warning LED 

This LED illuminates if the clock battery has been installed backwards.   

Reset Button 

Any time the reset button is pressed, the logger will begin a new data file. 
 

 A reset button is provided in the unlikely event that a nearby lightning strike or ESD event causes the 
SymphoniePLUS data logger electronics to lock up.  It is located between the battery box and the clock battery.   

 Should it become necessary to reset the SymphoniePLUS logger, place the NRG screwdriver (provided) in the upper 
corner just to the left of the ñCounter 4ò SCM slot and slide down.   

 Resetting the unit will cause up to 10 minutes of data to be lost (depending on how long since data was last written to 
memory) and will start a new data file.  

 SymphoniePLUS loggers with attached iPacks will initiate an automatic call (ñcold boot callò) 10 minutes after the 
logger is powered up.  If no antenna is attached or the call canôt be completed, no attempt will be made to call again 
until the next scheduled call or a ñCall Nowò is initiated by the user. 

 Collected data already written to memory and all configuration settings will be retained. 
 The reset button can also be used during field installation to start a new data file from the point at which all sensors 

have been connected.      
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Note that a reset can be also be initiated by the built-in watchdog in response to an ESD (electrostatic discharge) event.  
When an iPack is connected to a logger with no D-cells, this will also initiate a reset.  The iPack provides auxiliary power 
to the logger and therefore powers it up in the absence of D-cells.  

MMC Card Slot 

The MMC memory card installs into this slot with the beveled front corner down. 

SCM slots for counter channels 4, 5 and 6 

Each slot accepts a counter type Signal Conditioning Module (SCM).  These are used to configure the logger for 
additional counter type channels (in addition to the 3 built-in counter/anemometer channels).   

SCM slots for analog channels 9,10,11 and 12 

Each slot accepts an analog type Signal Conditioning Module (SCM).  These are used to configure the logger for 
additional wind vanes (in addition to the 2 built-in vanes channels) or other analog type sensors. 

Channel Description 

The SymphoniePLUS Logger has 15 input channels; 9 channels are counters and 6 are analog. 

Channels 1 ï 6 and 13 ï 15 (Counters) 

Channels 1 through 3 and 13 through 15 have built-in sensor interfaces for the NRG #40 Maximum anemometer and 
other anemometers with similar output signals.  Counter channels 4 through 6 can be configured by plugging an SCM into 
the corresponding SCM slot for that channel.  The SCM provides the electronics to configure the input for the sensor 
connected.  The SCM also sets up the channel as a speed (frequency) or totalizer for sensors such as tipping-bucket rain 
gauges or kWh meters.   

Channels 7 ï 12 (Analogs) 

Channels 7 and 8 have built-in sensor interfaces for the NRG #200P wind vane or other wind vanes with similar output 
signals.  Channels 9 through 12 are configured by plugging an SCM into the corresponding SCM slot for that channel.  
The SCM provides the electronics to configure the input for the sensor connected.  Appropriate SCMs in analog channels 
9 through 12 also describe to the logger whether the analog channel is a vane or other type of analog sensor. 
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Pre-Installation Setup:  Logger Configuration 

It is important to follow the instructions in this section in the sequence presented.  

Grounding 

Whenever coming in contact with the SymphoniePLUS logger, either in the field or indoors, it is good practice to first 
grasp a piece of grounded (earthed) metal before touching the logger to avoid a potentially damaging electrostatic 
discharge (ESD) to the logger. 

Installing SCMs 

If your site configuration requires more than the built-in six counter channels and two analog vane channels, it will be 
necessary to install appropriate Signal Conditioning Modules (SCMs) for each additional counter sensor (channels 4 
through 6) and each additional analog sensor (channels 9 through 12) to be connected to the SymphoniePLUS logger.  
Each SCM provides the necessary signal conditioning (filtering, gain, buffering and protection) electronics for the specific 
sensor type to be connected to the channel.   
 
Additionally, each SCM automatically sets the logging mode for the channel.  The logging mode determines how the 
SymphoniePLUS logger will process data gathered by each channel.  For each counter channel 4 through 6, the SCM 
identifies the logging mode as frequency (speed) or totalizer, and for each analog channel 9 through 12, the SCM 
identifies the logging mode as vane or not a vane.  

 
Before inserting an SCM in the appropriate slot, be sure to grasp the ground stud on the logger to prevent a 
potentially harmful static discharge.  The SCM has a metal strip on the top edge to facilitate grounding while 
being handled. 

     
 In order to install a SCM, it is necessary to remove the battery cover by loosening the three thumbscrews.  It is 

preferable that the logger is not powered while installing or removing SCMs, so the D-cells or iPack should not be 
installed at this time. 

 

 Install the SCM into the appropriate slot with the pins facing downward and the circuit components facing to the 
right. 

   
 Do not force the SCM.  

 
 The pins and connectors are ñkeyedò so that a counter SCM cannot be inserted into an analog slot. 

 
 Once the SCMs have been installed, the batteries can be installed, and the channels can be configured. 

  

Installing D-Cell Batteries 

 Open the logger enclosure and remove the battery box cover.  If you just installed SCMs, the cover should already 
be off.   

 Insert two fresh D-cell batteries, one at a time, into the battery holders with the positive terminals of the batteries 
(the end with the bump) oriented towards the sides of the enclosure.  When the batteries are first inserted, the 
display will read:  

 

 NRG Systems, Inc.  
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 Symphonie PLUS   

SN:  0000 0 

 Press [HOME]  

 Replace the battery box cover.  

 As a power saving function, the display will always shut off after one minute without any key inputs.  

 The display may also be shut off by pressing [Home] [3] [3].   

 The logger continues to collect data while the display is off.  
 

 

 
SCM cards installed under battery cover 
 

Setting Logger Display Contrast 

The SymphoniePLUSôs display contrast is pre-set at the factory but can be adjusted if necessary.  Please note that 
changes in contrast are temporary.  When the display is powered up again, the default contrast setting will appear.  This is 
to avoid the screen being accidentally set so that it canôt be read (completely black or completely white). 
 
[Home][3][2] = Set Display Contrast 

 

Use up and down keys  

 to adjust contrast  

 

ESC=Quit  Set=Accept  

Setting and Verifying Logger Units (Imperial or SI) 

Sensor lists are used to configure each channel of the logger.  There are two internally stored factory loaded sensor lists, 
one with scale factors in Imperial units and one with scale factors in SI (metric) units.  Setting the logger units to Imperial 
will load the sensor list with the scale factors in miles per hour, and the site elevation and sensor height units will default to 
feet. 

 
Setting the logger units to SI will load the sensor list with the scale factors in m/s, and the site elevation and sensor height 
units will default to meters.   
 
Note that this will not change the currently stored scale factors for each channel in the logger.  You must always 
confirm the scale factors and units for each logger channel individually. 

 

 Press [Home][4][3][3]  

 Use the [UP] and [DOWN] navigation keys to select Imperial or SI. 

 Press the [Set] key to accept the selected units or press [ESC] to quit without changing the units.  
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Channel Configuration Sequence ï choosing a sensor, setting and verifying each logger channel 

It is recommended that the channels are configured only after the logger units have been set to either Imperial or SI as 
described above.  Default sensor configuration values are preprogrammed for NRG sensors and can typically be used to 
simplify the configuration process. 

 
To begin the configuration process, press [Home][4]. The following display will appear: 

 

  1. Count (Ch 1 - 6)  

 2. Analog (Ch 7 - 12)  

 3. Logger Settings  

 4. Count (Ch 13 ï 15)   
 

 

 Pressing [1] will display a list of the 6 currently active counter channel descriptions from memory. 
 Pressing [2] will display a list of the 6 currently active analog channel descriptions from memory. 
 Pressing [4] will display a list of the other 3 currently active counter channel descriptions from memory. 
 Scroll through the desired list of six channels using the [UP] and [DOWN] arrows.  
 Press the corresponding number for the channel you wish to configure [for example, 1, 4 for channel 14].  This will 

display the currently active channel description.   
 You may now edit the currently displayed channel by pressing [SET], or you may select a new configuration from 

the loaded sensor list by pressing the [Down] arrow key to scroll until the desired sensor description appears.  
When you have scrolled to the correct sensor description, press [SET] to edit.  Any changes will be loaded as a 
working copy into temporary memory and will be saved and finalized after the configuration process for the channel 
is completed. 

 Note that the currently selected sensor description will be followed by [Set] to Change on the LCD. 
    

   Channel 1: Frequency  

   NRG #40 Anem.  m/s  

   [Set] to Change  

   [Down] for Defaults  

 
Other possible sensor description choices will be followed by Up, Down to select and ESC=QUIT  SET=ACCEPT.   

-> Description (Sensor Model) 

Edit the sensor description if desired by using the keypad and navigation keys.  Press [SET] when the sensor description 
is correct.  The description is now loaded into the temporary memory and will be saved after the configuration process for 
this channel is completed.  The scale factor editing screen will appear next. 

-> Scale Factor 

Enter the scale factor exactly and be careful to place the decimal point into the correct place.  Edit the sensor scale factor 
if desired by using the keypad and navigation keys.  Press [SET] when the sensor scale factor is correct. The scale factor 
is now loaded into the temporary memory and will be saved after the configuration process for this channel is completed.  
The offset editing screen will appear next. 

-> Offset 

Edit the sensor offset if desired by using the keypad and navigation keys.  Press [SET] when the sensor offset is correct. 
The offset is now loaded into the temporary memory and will be saved after the configuration process for this channel is 
completed.  The units editing screen will appear next.   

-> Units 

The SymphoniePLUS Logger may be set to use ñmixedò units ï that is, one can use SI units for some channels and 
Imperial units for others.  Additionally, the units for each channel do not need to match the units that have been set for site 
elevation (altitude) and sensor height.  Edit the sensor units if desired by using the keypad and navigation keys.  Press 
[SET] when the sensor units are correct.  The units are now loaded into the temporary memory and will be saved after the 
configuration process for this channel is completed.  The height editing screen will appear next. 
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-> Height 

Edit the sensor height if desired by using the keypad and navigation keys.  The sensor height may be up to 4 characters.  

Press [SET] when the sensor height is correct. The height is now loaded into the temporary memory and will be saved 
after the configuration process for this channel is completed.  The serial number editing screen will appear next. 

-> Serial Number 

Edit the sensor Serial Number (SN) if desired by using the keypad and navigation keys.  It is an 8 character 
alphanumeric field.  Press [SET] when the sensor Serial Number (SN) is correct.    
 
All channel parameters that were loaded into temporary memory during editing are now finalized, and the configuration 
of this channel is now complete.  The SymphoniePLUS data logger will return to the channel selection menu, and the 
process is repeated for the next channel. 

Setting and Verifying Site information, Time Zone, Clock and Data Encryption 

Time Zone and Logger Clock (Time and Date) 

 Press [Home] [4] [3] [1] to display the screen that sets the appropriate time zone (the logger defaults to zone ï5: 
American Eastern Standard Time).   

 Use the [Up] or [Down] arrows to scroll to the proper zone for your site, then press [Set] to accept.  The logger will 
update the time zone and then display the prompt: 
 

Set Date and Time  

02/15/2003   15:26  

mm/dd/yyyy   hh :mm 

ESC=Quit   SET=Accept  

 
Remember to use local standard time (not daylight savings time). Press [Set] to accept. 

Site Number 

 Press [Home [4] [3] [2] to set your unique site number.   

 The Site Number field initially defaults to the loggerôs serial number but can be reset to any four digit number.  

Site Altitude (Elevation) (optional) 

 Press [Home] [4] [3] [4] to set site elevation.   

 Site elevations will be expressed using the units (Imperial or SI) previously selected.   

 Site elevations below sea level can be set by using a ñ-ò in the first position.  The ñ-ñ can be found in the navigation 
keys (the top row of the keypad). 

Site Latitude and Longitude (optional) 

 Press [Home] [4] [3] [5] to set site latitude. 
 Use the [Up] [Down] navigation keys to toggle between north and south (ñNò and ñSò), and use the keypad to edit 

the displayed latitude information. 
 When the latitude information appears as desired, press [SET]. 
 Use the [Up] [Down] navigation keys to toggle between east and west (ñEò and ñWò), and use the keypad to edit the 

displayed longitude information. 
 When the longitude information appears as desired, press [SET]. 
 Enter latitude and longitude in decimal degrees (rather than degrees, minutes, seconds) 

  

Data Encryption PIN Number (optional) 

As a security measure, SymphoniePLUS can encrypt data before storing it on the MMC.  A Data Encryption PIN Number 
can be entered into the logger to enable data encryption.  Note that this is an optional feature intended only for those for 
whom data theft is a risk.  Data encryption can be disabled by setting the PIN to 0000.  The data encryption PIN number is 
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set to 0000 (disabled) at NRG before shipment.  If the data are stored in encrypted format on the MMC, the encryption 
PIN number will also be needed for the SDR software to decrypt the data.   
 
Do not lose the Data Encryption PIN number!  You must know the PIN in order to disable or change it. 
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Symphonie Data Retriever Software and Accessories     

  

Symphonie Data Retriever Software Functions 

 Reads binary data files that have been stored on the computer hard disk from an email or MMC reader source.   
 Stores site information.  
 Configures iPacks through the use of a programming cable. 
 Reads files generated by SymphoniePLUS, Symphonie, 9300, 9200-PLUS, and Wind Explorer data loggers, scales 

them according to a user-defined site file, and converts them to tab-delimited ASCII files readable by Notepad, Excel, 
etc. 

 Imports data into a self-contained MicroSoft Access compatible database. 

 Exports data as tab-delimited 10 minute, 60 minute .txt files or WASP format for any time range. 

 Generates Wind Rose, Frequency Distribution and Summary reports for any time range. 
 

Please be sure to open the ñRead Meò file and check for any updates that may not have been included 
in the printing of this manual. 

System Requirements 

 Symphonie Data Retriever runs on Windows 95/98/2000, Windows ME, Windows XP Home, Windows XP 
Professional, and Vista computer operating systems and installs from a CD drive or can be downloaded from 
www.nrgsystems.com.   

 A USB port is required to use the MMC Card Reader which allows you to read data from the MMC Flash cards.   

 A standard DB9 COM port is required to program the iPack parameters.  Note that in many cases, a USB to serial 
converter can be used in place of a real COM port. 

Related Hardware Accessories 

 MMC reader 

 iPack programming cable 

 Optional USB to serial converter cable 

Installation 

Symphonie Data Retriever Software must be installed in order to program iPacks or read data files.  Load the CD-ROM.  
Use Windows Explorer to find SDRInst.exe, and double-click the file to start the installation. 
 

1. Select the options you want to install.  If you are not sure, leave all the boxes checked.  Hit ñNext.ò 
2. Choose the target directory for your installation.  If you are not sure, leave it un-changed and hit ñNext.ò 
3. When the installation is complete, hit ñClose.ò  If you are prompted to restart, do so now. 
4. You are now ready to program iPacks or process files. 

 

Please note that a default printer driver must be assigned before the software will run.  You may use Windows Control 
Panel to do this.   
 
Some versions of Windows do not allow users without administrator access to modify Windows system files.  The user 
must have access privileges to install Symphonie Data Retriever. 
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If your PC does not have a CD-ROM drive, the Symphonie Data Retriever Software may also be downloaded from the 
NRG Systems web site: 
 

1. Go to the NRG Systems web site at http://www.nrgsystems.com, and go to the Free Software Downloads 
section of the Tech Support page.   

2. Click on the link for SDRInst.exe and when asked, choose ñRun from current location.ò 
3. When the download is complete, the program will start. 
4. You are now ready to program iPacks or process files. 
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Pre-installation Setup: iPack Accounts 

 

WindLinx Wireless Service  

iPacks shipped after June 1, 2010 are pre-configured for WindLinx wireless service.  WindLinx streamlines the wireless 
account set-up process and simplifies overall management of met tower data transfer from multiple sites around the 
world.  WindLinx provides satellite, GSM, or CDMA service plus internet service via the WindLinx web portal, all from a 
single supplier.  A form with instructions for activating and managing WindLinx accounts is included with each iPack.  
During the setup process, the WindLinx web portal will generate necessary programming parameters for the iPack, so 
much of the information provided in this section and the next chapter, Pre-installation Setup:  iPack configuration is not 
required for WindLinx subscribers. 
 
Customers wishing to work with their own service providers have the option to do so according to the instructions provided 
below. 

GSM Cellular Account  

Before installing your GSM iPack, a GSM cellular account must be activated by a cellular service provider.  Your GSM 
service provider will supply you with a SIM card that contains the GSM cellular account programming information.    
 
The account associated with the SIM should be set up for GPRS.  Be sure to ask your GSM provider about the different 
types of accounts and service availability for your area. 
 
The SIM card must be installed into the GSM iPack before the unit can be installed.  Detailed instructions for opening and 
closing the iPack can be found in the Appendices of this manual.  A PIN (Personal Identification Number) number may 
also be provided and is supported by SymphoniePLUS.  Be sure to inform your cellular service provider that you need the 
account enabled for data service. 

 
Record your GSM iPack cellular parameters using the GSM iPack Data Sheet worksheet found in the Appendices of this 
manual. 

CDMA Cellular Account (Verizon Only) 

Before using your CDMA iPack, a data account must be established with the Verizon CDMA service provider.  In order to 
activate your CDMA account, you will need to provide Verizon with the CDMA iPack Electronic Serial Number (ESN).  The 
ESN number can be found on a label on the CDMA iPack.  Once you have given the ESN to the cellular provider and the 
account has been activated, you will need to register the phone in a Verizon home area.  This is done through SDR by 
connecting the iPack directly to your computer, or by accessing the iPack through the loggerôs iPack access port, or 
through menus accessed from the loggerôs keypad.  The phone will then download the account information automatically. 
 

CDMA Cellular Account (Canada / Telus Only) 

Before using your CDMA iPack, an account must be established with the Telus CDMA service provider.  In order to 
activate your CDMA cellular account, you will need to provide Telus with the CDMA iPack Electronic Serial Number 
(ESN).  The ESN number can be found on a label on the CDMA iPack.  Once you have given the ESN to the cellular 
provider and the account has been activated, you will need to register the phone in a Telus home area.  This is done 
through SDR by connecting the iPack directly to your computer and sending a registration string of *22886 using the 
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ñinitialize phoneò button, or doing the same by accessing the iPack through the loggerôs iPack access port.  It is not 
possible to register the phone from the loggerôs keypad.  The phone will then download the account information 
automatically. 

Satellite Account  

Before installing your satellite iPack, an account must be established with a satellite service provider that utilizes the 
Iridium satellite network.  Complete the activation form included with the satellite iPack and fax to the satellite service 
provider as instructed on the form.  A copy of this activation form can be found in the Appendices of this manual.  The 
satellite phone in the iPack will be active once confirmation is received from the satellite service provider.  

Internet Service Provider (ISP) Account (all iPacks) 

Before installing your iPack, an Internet Service Provider (ISP) account must be activated.  The ISP must be capable of 
handling dial-up connections, be compatible with either PAP or CHAP authentication methods, be able to recommend 
Domain Name Service (DNS) servers, and have an SMTP server available for use.  The SMTP server must connect over 
port 25.  A POP3 server name, mailbox name and mailbox password are required, and you may use the ones provided by 
your ISP. 
 
For GSM iPacks utilizing GPRS service, SMTP server information can sometimes be obtained from the cellular service 
provider.  Remember that SMTP servers are used to send email from the logger.  However, you will still need a POP3 
mail account (to receive patch files), which will likely not be provided by the cellular carrier.  Multiple loggers can share 
one POP3 account between them, but this account should not be used for anything other than SymphoniePLUS.  If you 
do not already have a POP3 account for your loggers, you can obtain one from an email provider. 
 
The POP3 mailbox MUST remain clear of SPAM and other email.  The iPack checks the POP3 mailbox at the end of each 
successful data transmission.  Email other than a patch file residing in this mailbox will increase airtime unnecessarily.   
 
Multiple loggers can share a single ISP account just as multiple users can share one ISP account.  Check with your ISP 
provider to see if more than one user can be logged in to an ISP at any one time.   
 
NRG recommends having a separate, logger-only ISP account to make handling your data easier and avoid access 
conflicts.  It is recommended that the assigned iPack ISP account is NOT the same account you use for your personal 
internet access.  Each ISP account allows access for one user at any given time.  This means that your day-to-day office 
internet access could obstruct the iPackôs internet access.  If the ISP is busy with another user, the iPack will try again 
later.  Repeated attempts to access the internet are a waste of battery power and should be avoided.
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Pre-installation Setup:  iPack Configuration 

Items required to configure (program) an iPack 

You will need the following items to configure an iPack.  Be sure you have all of these items before continuing: 

 Symphonie Data Retriever Software 

 Computer - system requirements are specified in the Symphonie Data Retriever Software and Accessories 
section of this manual.  You must follow the instructions to install the software before proceeding. 

 iPack programming cable (available from NRG Systems) 

 All ISP and phone account information (WindLinx subscribers will be provided this information from the WindLinx 
web portal) 

Configuration (Programming) recommendations 

iPack configuration should be done in the office before going to the field.  Bringing an ñactive, ready to goò iPack to the 
field will insure the installation can be performed as quickly as possible, saving valuable field time and expense.  Please 
note that if your logger revision is 8,7,11 or later, you have the ability to program the iPack through the loggerôs iPack 
Access Port.  However, the iPack Access Port is intended for field use.  For pre-installation programming of iPacks in your 
office, we recommend using the programming cable with PC as described below. 

Grounding 

Please take care to observe good grounding practices when configuring your iPack.  If you are in a dry office environment, 
make sure to discharge yourself before handling the iPack.  The best solution is to place the iPack on a grounded anti-
static mat. 

Connecting the iPack to the Computer  
Connect the iPack using a standard 9-pin female to 25-pin male ATModem cable to the serial port on your PC.  The 9-pin 
end goes to the PC, and the 25-pin end goes to the iPack.  Connect the computer end first, then the iPack end. 

Starting Symphonie Data Retriever iPack Configuration Software 

Start the Symphonie Data Retriever Software from the Windows Start menu.  The program is usually found here:  
C:\NRG\SymDR\SDR.exe. 

Establishing communication between the computer and iPack 

From the main SDR Window, select Site>Modify iPack Settings.  Check the lower left hand corner of the Modify iPack 
Settings window for a message.   
 
If you receive no message or ñiPack Communication Failed,ò it is likely that the COMM port on your computer is not 
configured properly.  You must disable any programs such as Palm HotSync that might be trying to access the COMM 
port. 
 
Select Options>Comm Port from the menu, and select the communication port you will be using to connect to the iPack.  
The COMM port setting will be restored the next time you use the program and only needs to be entered the first time you 
use the program or following a reinstallation of SDR software.   
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Note:  If none of the COMM ports in the Select Comm Port window can be selected, you will need to use Windows Control 
Panelôs Device Manager to change the COMM port number to 1, 2, 3, or 4. 
 
If the port is properly configured, you should see the message ñVerifying iPack Connectionò and then ñiPack detectedò at 
the bottom of the window. 
 

 
 

Phone Programming & Initialization Overview - Set Up Phone  

You will want to take extra care during this section.  It is recommended that you get the iPack working before bringing it to 
the field for installation!  The phone setup process is separate from the ISP setup and must be sent to the phone as 
described here. 
 
At this point, you have established communication between the iPack and your computer.  The embedded GSM phone 
will need to be programmed through SDR with the account information provided by your cellular service provider.  iPacks 
with WindLinx are pre-initialized at the factory; non-WindLinx CDMA and Satellite iPacks require initialization.  . 
 
From the Modify iPack window, select Options>Set up Phone.  The appropriate type of phone (GSM, CDMA, Satellite, 
etc.) button should already be selected.  Note that at any time on the Set Up Phone screen, you may press the Get button 
to retrieve the currently loaded phone settings.   
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Phone Programming - GSM cellular 

The GSM phone programming functions are performed through the GSM SIM (Subscriber Identity Module, a smart card 
containing the telephone number of the subscriber, encoded network identification details, the PIN and other user data 
such as the phone book).  Your GSM provider will supply you with a SIM that you will install into the phone.  GSM 
accounts should be configured for General Packet Radio Service (GPRS) since Circuit Switched Data (CSD) is no longer 
available in many areas.  Please note that GSM iPacks shipped prior to April 2006 (SN:3122xxxx) cannot handle GPRS 
connections.  GSM iPacks shipped after June 1, 2010 include a WindLinx enabled SIM. 

Installing a SIM card into a GSM iPack  

GSM users will need to open the iPack and install a SIM card into the GSM Data Modem.  WindLinx subscribers do not 
need to open the iPack as the WindLinx SIM is already installed. 

Opening the iPack 

Be sure to touch the metal shell of the DB25 connector on the iPack before opening the enclosure in order to safely 
discharge any static electricity. 
 
The iPack enclosure consists of two halves secured together by four recessed screws, two from each side of the 
enclosure.  A gasket in between the two halves and 8 o-rings provide an environmental seal for the iPack protecting the 
internal electronics from the elements. 
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Remove the four recessed screws, and the iPack will separate into two halves.  For older iPack models a short cable will 
connect the two halves.  One half contains the iPack electronics, and the other half contains the rectangular battery which 
is secured by Velcro.  For the newer GSM iPacks, the battery and electronics will be found on the same half.  The GSM 
transceiver is located to the left of the battery.  Try not to lose any of the o-rings, and be careful not to rip or tear the 
gasket if it should come loose.  Note that each iPack leaves the NRG factory with a small bag of spare o-rings inside the 
iPack.   
 

  
 

 
Once the iPack cover is off, find the GSM transceiver.  Install the SIM in the GSM Data Modem by gently sliding it in.  
Older GSM Data Modems will have an outline of the correct SIM orientation.  Be sure to install the SIM so that the gold 
contacts are facing down and the SIM cardôs notched corner is aligned to the top right, as seen in the picture above.  First-
generation GSM Data Modems will have a hatch that needs to be opened before the SIM can be inserted.  Secure the 
hatch (if applicable), and then reassemble the iPack. 
 

GSM Transceiver 






































































































































































































